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 Rise Display Network Appliance Configuration for Samsung 
This document outlines the recommended Windows settings to optimize the performance of your 
Samsung DXN series displays and should be similar for other models such as CXN, MXN, PXN, and 
UXN series displays.  Given the amount of models and frequency of changes we are only able to provide 
these as guidelines and suggest you contact Samsung if something has changed with their configuration. 

Please note that we would consider these embedded PCs for basic applications and you should run tests 
to ensure the system is robust enough to run your desired content.   

If you are using a TV tuner on the LCD display note that our software does not allow you to place that TV 
in a window within the content.  For TV to work within a presentation controlled by Rise Display Network 
the TV tuner has to be integrated into the computer/PC. 

Disabling EWF and uninstalling Magic Net 

Once the appliance has started and is displaying the Magic Net menu options, go into the Setup option, 
the default password to get into the Setup is 000000. 

Go to the Options menu, and highlight the radio button Disable for EWF. Once you have done this, 
press Commit, and reboot the machine. 

Once the machine reboots, open the Windows Task Manager and end the process for the programs 
Beethoven II and Magic Net. Once you have done this, go to the Add/Remove Programs menu from 
Control Panel, and uninstall Magic Net. Once this has been uninstalled, reboot the machine.  

Display Properties 
Right click on the desktop and choose Properties for all of the following: 

a. On the Desktop tab, click the Customize Desktop button, and uncheck the “Run 
Desktop Cleaning Wizard every 60 days” checkbox. 

b. On the Screensaver tab, change the screensaver to the “None” option. 

c. From the Screensaver tab click on the Power Options button then on the Power 
Schemes tab, set the scheme to “Presentation”. 

d. On the Appearance tab, click the Effects button. Ensure that the checkbox “use the 
following method to smooth edges of screen fonts” is checked, and the choice in the 
drop down box is “Standard”. 

e. On the Settings tab, set the resolution to 1366 x 768 and the color quality is Highest (32 
bit).  

f. Finally, after closing Display Properties, right click on your taskbar (not the desktop) 
choose Properties. Check the “Auto-hide the taskbar” checkbox, and uncheck “Keep 
the Taskbar on top of other windows”. 

Operating System Settings 
Right click on My Computer and choose Properties for steps a - d: 
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a. On the Advanced tab, click the Error Reporting button. Choose the option “Disable Error 
Reporting” and uncheck the “But notify me when critical errors occur” checkbox. 

b. Again on the Advanced tab, in the Startup and Recovery section, click Settings. Ensure 
that “Write an event to the system log” and “Automatically Restart” are checked. 

c. Again on the Advanced tab in the Performance section, click the Settings button, and on 
the Visual Effects tab, choose the “Adjust for Best Performance” radio button. 

d. Lastly on the Advanced tab, in the Performance section, click the Settings button. Go to 
the second tab called Advanced and then in the bottom section marked Virtual Memory, 
click on the Change button. Highlight the C Drive, select the “No Paging File” Option, and 
press Set. Then highlight the D Drive, change the min and max values to 670, and press 
Set. Restart the machine. 

Click on Start   Control Panel for steps e - i: 

e. In the Folder Options menu, click on the View tab. In the list, uncheck the “Show pop-up 
description for folder and desktop items” option.  

f. Lastly in the Folder Options menu, choose the Offline Files tab. Uncheck “Enable 
Offline Files”. 

g. In the Administrative Tools menu, click on Component Services -> Services. Right click 
on each Service listed below and choose Properties. Change the startup type from 
“Automatic” to “Manual”:  

• "Message Queuing" 

• "Print Spooler" 

• "Smart Card" 

• "Themes" 

• "Windows Time" 

h. Double click on the My Computer icon, and then right click on the C: Drive and choose 
Properties. On the General tab, uncheck the “Allow Indexing Service to index this 
disk for faster file searching” checkbox. On the next dialog screen, leave the default 
value “Apply changes to C:\, subfolders, and files” highlighted, and click OK. The 
process may say that “access is denied” to some files. On the first instance of this, 
choose “Ignore All”. 

i. Click on Start Run, and run regedit. In Regedit, navigate to this registry key: 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced 
Right click in the right pane, and select New and the create a new DWORD value. Name 
the new DWORD value EnableBalloonTips. Double click the value and give it a value of 
0 (zero). Quit Regedit, and restart Windows. 

Internet Explorer Settings 
Open Internet Explorer, and go to Tools   Internet Options for steps a - f: 
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a. On the General tab, in the Temporary Internet Files section, click the Settings button. 
Change the “Check for newer versions of stored pages" radio button to "Every visit to 
the page". Change the “Disk Space To Use” to 1. 

b. On the Security tab, click Custom Level. [NOTE:  You need to do this once each for 
Internet and Local intranet]  

• Under Miscellaneous, change the following: 

i. Enable  "Allow Web pages to use restricted protocols for active content" 

ii. Enable  "Display mixed content" 

c. On the Content tab, click the AutoComplete button. Uncheck all AutoComplete boxes 
(Web Addresses, Forms, User names and passwords) 

d. Change the View Settings in Internet Explorer by doing the following: Start Internet 
Explorer, and click on the View menu. Change Encoding to “Auto-Select”, and Text Size 
to Medium. 

Software Versions 
a. Install the latest versions of: 

• Windows Media Player: www.windowsmediaplayer.com 

• Divx For Windows: http://www.divx.com/divx/windows/download/index.php 

• Flash Player: www.adobe.com. (in the Folder Options menu, go to the File 
Types tab. Once there, search for the file type “.swf”. Click on the Advanced 
button, and uncheck “Confirm Open After Download”.) 

• VNC Server (Free Edition): www.realvnc.com (**Important – remember your 
password**) 

RDNA Installation 
a. Install the latest version of rdna with all the default selections during installation: 

http://www.risedisplaynetwork.com/Installs/RiseVision.exe 

b. Reboot the machine, upon reboot, your machine will begin playing demo content shortly. 
Wait up to 5 minutes for the demo content to begin running, and then Press Ctrl + Shift + 
F11 to pause the presentation and do the following tweak to the Windows Firewall. 

Windows Firewall Settings 
a. Add exceptions to the Firewall to ensure your content and VNC Server run correctly by 

doing the following: Follow this path: Start  Control Panel  Windows Firewall. Click on 
the Exceptions tab, and ensure that the “Display a notification when Windows 
Firewall blocks a program” is checked. In the list of Programs and Services, check "File 
and Printer Sharing", and uncheck "Remote Assistance" 

Click the Add Program button, and add the following program: Rise Display Network 
Appliance Configuration 
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Click the Add Button again, and add the following programs by clicking Browse: 

• C:\Program Files\RealVNC\VNC4\winvnc4.exe 

• C:\Program Files\RealVNC\VNC4\vncviewer.exe 

• C:\Program Files\RealVNC\VNC4\vncconfig.exe 

• C:\Program Files\Rise Softools\Rise Auto Update\RiseVision.RAU.exe 

• C:\Program Files\Rise Softools\Rise Vision Enterprise\RisePlayer.exe 

• C:\Program Files\Rise Softools\Rise Vision Enterprise\Rise Data 
Collector\RDC.exe 

• C:\Program Files\Rise Softools\Rise Vision Enterprise\Rise Data 
Drivers\datamngr.exe 

RDNA Installation 
c. Install the latest version of rdna with all the default selections during installation: 

http://www.risedisplaynetwork.com/Installs/RiseVision.exe 

d. Reboot the machine, upon reboot, your machine will begin playing demo content shortly. 
Wait up to 5 minutes for the demo content to begin running, and then Press Ctrl + Shift + 
F11 to pause the presentation and do the following: 

• Click Start, and then Run, and type in eventvwr. In the Event Viewer, right click 
on the Rise Display Network Appliance Log and choose Properties. Change 
the radio button selection to “Overwrite Events as Needed”, and press “Apply”. 

• If you are going to leave the Windows Firewall enabled, tweak to the Windows 
Firewall to the specifications below. 

Windows Firewall Settings 
b. If you are in an environment where you can safely turn off the Windows Firewall, turn it off 

by doing the following: Follow this path: Start  Control Panel  Windows Firewall. 
Change the status of the Firewall from On (Recommended) to Off (Not Recommended). 

c. If you prefer to leave the Windows Firewall on, you can add exceptions to the Firewall to 
ensure your content and VNC Server run correctly by doing the following: Follow this path: 
Start  Control Panel  Windows Firewall. Click on the Exceptions tab, and ensure that 
the “Display a notification when Windows Firewall blocks a program” is checked. In 
the list of Programs and Services, check "File and Printer Sharing", and uncheck 
"Remote Assistance" 

Click the Add Program button, and add the following program: Rise Display Network 
Appliance Configuration 

Click the Add Button again, and add the following programs by clicking Browse: 

• C:\Program Files\RealVNC\VNC4\winvnc4.exe 

• C:\Program Files\RealVNC\VNC4\vncviewer.exe 
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• C:\Program Files\RealVNC\VNC4\vncconfig.exe 

• C:\Program Files\Rise Softools\Rise Auto Update\RiseVision.RAU.exe 

• C:\Program Files\Rise Softools\Rise Vision Enterprise\RisePlayer.exe 

• C:\Program Files\Rise Softools\Rise Vision Enterprise\Rise Data 
Collector\RDC.exe 

• C:\Program Files\Rise Softools\Rise Vision Enterprise\Rise Data 
Drivers\datamngr.exe 

•  C:\Program Files\Rise Softools\Rise Vision Enterprise\Rise Data Drivers\Reuters 
SFC Data Driver\ ReutSFC.ddr 

• C:\Program Files\Rise Softools\Rise Vision Enterprise\Rise Data Drivers\Bridge 
Data Driver\ bridge.ddr 

d. Allow the appliance to receive incoming echo requests by doing the following: Follow this 
path: Start  Control Panel  Windows Firewall. Click on the Advanced tab. In the ICMP 
section, click on the Settings button. Check the “Allow incoming echo request” 
checkbox. 

Proxy Setup 
If you are using a Proxy, you will need to enter in the proxy server, port and any user 
authentication in the Rise Display Network Appliance configuration.  Click on Start  All 
Programs  Rise Vision  Rise Player Configuration to enter the values. 

The proxy information will also need to be placed into the appropriate data driver (Financial Wire 
as an example).  Right-click on the Rise Data Provider in the System Tray and select Properties.  
Click on the question mark on the right-hand side, next to where it says Financial Wire.  Click on 
Yes at the prompt: ‘DataSource “FinancialWire” is online.  Show Properties Dialog for Rise 
FinancialWire Data Driver on local PC’. Click on the Settings tab and enter the proxy server 
information. 

Wireless Appliances 
We do not recommend an appliance run wirelessly due to the network bandwidth that can be 
consumed by the Digital Signage Application, however if your appliance is going to be connected 
wirelessly to download content, we recommend doing the following: 

Have a scheduled task that runs this restart script every 12 – 24 hours. Since the wireless 
connection may not be available once the Rise Display Network Appliance service starts, this can 
result in no presentation starting since an internet connection is not readily available. This script 
will restart the Rise Display Network Appliance Service on the appliance at the specified times 
you want the scheduled task to run.  

This restart script is not necessary for appliances that will be connected via an Ethernet network 
connection. 

To set up this Restart Script as a scheduled task, please do the following: 
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a. Download the restart script and save it on your appliance: 
http://test.risedisplaynetwork.com/downloads/Restart%20Script/RestartScript.vbs 

b. Click on Start  All Programs  Accessories  System Tools  Scheduled Tasks 

i. Click Add Scheduled Task. 

ii. Click Next. 

iii. Click Browse to find the RestartScript.vbs, and then press Next. 

iv. Give the task a name and choose Daily for how often you want it to execute. 

v. Choose the time you want the task to run. 

vi. Leave the password blank unless the logged in user has been assigned a 
password. 

vii. Check the box to Open advanced properties for this task when I click finish, 
and click Finish. 

viii. On the Task tab, check the box at the bottom “Run only if logged on”, and then 
click Apply.  

ix. Click OK to save the task. 

Create a task for as many times as you want this scheduled task to occur. We recommend every 
12 – 24 hours. 

Image Preparation 
Option 1 

If you would like the appliance to not start playing demonstration content upon start up, and 
instead have a link on the desktop that a user would click on to begin using the Rise Display 
Network, follow these steps. 

i. Download the RDNA Auto Installer Deployment files from here: 
http://test.risedisplaynetwork.com/downloads/RDN%20AI/RiseVision.RDNA.zip).  

ii. Update the windows service “Rise Display Network Appliance Service” 
a. Change the start-up type to “Manual”. 
b. Stop the service. 

iii. Ensure that the Rise Player, Rise Data Provider, and Rise Data Collector are not 
running. 

iv. Delete the file “RiseDisplayNetworkAppliance.xml” from C:\Windows\system32. 
v. Unzip all files in the downloaded zip file to this location: 

C:\Install\RiseVision.RDNA.AI 
a. RiseVision.RDNA.AI.exe 
b. RiseVision.RDNA.AI.exe.config 
c. Interop.IWshRuntimeLibrary.dll 
d. Activate Rise Player.lnk 
e. TBYB.bmp 

vi. Copy the Activate Rise Player.lnk file to these locations:  
a. All Users Desktop 
b. All Users Start Menu  Programs  Rise Vision 
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Option 2 

If you prefer the appliance begin playing content once Windows starts, click Start  Run  
Services, and stop the “Rise Display Network Appliance Service”. Once that service is stopped, 
delete the following files and folders before the appliance is imaged: 

• C:\Windows\System32\RiseDisplayNetworkAppliance.xml 

• C:\Windows\RiseVision\Cache 

• C:\Program Files\Rise Softools\Rise Vision Enterprise\Temp\Cache 

**Important – Make sure that the appliance does not reboot into Windows after the files and 
folders above have been deleted. 

 

Sysprep Preparation 

To build an image of your appliance for production, we recommend using Sysprep. A step by step 
guide to using Sysprep has been written by Microsoft, and is available here: 
http://support.microsoft.com/kb/314472.  

Run sysprep.exe on the appliance, and choose to reseal the appliance. Ensure that the option to 
regenerate SID’s when the appliance restarts is chosen. 

Once the machine has shut down after the Sysprep reseal, image the appliance with the imaging 
software of your choice. 

If you have any questions or concerns, please feel free to contact our support team at 
support@risevision.com.  

 

Thank you for choosing the Rise Display Network.  If you have any 
feedback regarding this document, please direct them to 
support@risevision.com 


